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Baskets
4	� Here’s a pretty quilt from Alex Anderson featuring the ever-popular basket block. Turning 

the blocks on their sides in the even-numbered horizontal rows creates an interesting 
secondary pattern. 

Photo Quilt Block or Scrapbook Page
8	�E xpand your creativity – try something new! Print a photo onto fabric using your inkjet 

printer, then use v6 BERNINA Embroidery Software to incorporate your printed photo into 
a fun embroidered quilt block. 

Holiday Elegance OrnamentS
10	�M ichelle Griffith of Michelle’s Design offers this quick-and-easy ornament for your holiday 

decorating. The embroidery design is from the “Holiday Elegance” design collection, a 
Designer Exclusive from Brewer Quilting and Sewing Supplies.

Bias Bound Borders
12	� Have fun making these placemats utilizing your BERNINA accessory feet. Linda Wenturine 

used pintucks, circular embroidery, bias binding, and machine embroidery to personalize 
and embellish these placemats. 

TABLETOP SEWING CADDY
14	�U se this handy caddy featuring designs from OESD’s “Head Over Heels” collection to hold 

sewing utensils and crafting supplies.

Wrap it up
16	�E very year the piles of post-Christmas wrappings and boxes seem a bit higher. This year 

we wanted to show you how you can wrap your gifts in an environmentally friendly way and 
give the recipient some extra benefit from the packaging. 

Lovely Lingerie Bag
18	�U se your BERNINA 830 to combine imported stitches with exclusive Susanne Müller 

designs, creating an endless embroidery design to embellish this lovely lingerie bag. It’s 
the perfect place to store all your “pretty little things.” 

Radiant Circles
20	�T his beautiful, intricate design from Libby Lehman makes an impressive quilt, and 

Circular Embroidery Attachment #83 makes it so easy and fun to stitch!

Breaking the Quilting Rules
24	�D ing dong! Have you heard? The quilting police are dead! And if they don’t care whether 

your quilts follow some antiquated rules or not, why should you? 

Perfect Hems in Knits
25	�T ips from Linda Lee and Project Sewing Workshop help you create perfect hems in knit 

garments. 

Bring on the Bells
26	�D ress your mantel in a covering of sweet golden bells strewn across a snowy white mantel 

scarf. Designed by Bobbi Bullard, it’s easy because the quilting is done in the embroidery 
hoop. 

Stacked Stitch Recipe
29	�T his is probably the only fun, calorie-free recipe you’ll ever see. That’s because it’s done 

on a BERNINA sewing machine! 

CLAIM CHECK
31	�F ollow these simple instructions from BERNINA and ReadyMade to sew a personalized 

luggage tag that’s sure to make your suitcase stand out from the crowd.

Fashionista….Explore the Possibilities
33	�M y Label 3D Fashion Pattern Software offers you endless possibilities for adapting the 

existing designs to create your own design. The Fashionista dress was created using a 
pattern manipulation technique with My Label software. 

On the Cutting Edge with BERNINA CutWork
34	�T he innovations team at BERNINA International has developed a way to eliminate the 

hand cutting necessary in so many sewing projects. Sarah Caldwell tells us all about the 
exciting new BERNINA CutWork Tool and Software! 
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needle notes
Summer is over, the kids are back in school, and the weather is getting colder. It’s 
the perfect time to start sewing for the holidays, and to get working on the quilting 
projects it was just too hot to tackle during warmer weather. 

We’ve selected several quilting projects for this issue, with something for every type 
of quilter – a twist on a traditional Basket pattern from Alex Anderson (page 4), 
a layered free-form art quilt from Libby Lehman (page 20), and a quilting-on-
the-embroidery-machine project from Bobbi Bullard (page 26). And don’t let the 
“quilting police” keep you from trying something new – Nancy Monson provides a 
list of quilting rules that you have permission to break (page 24). 

For your holiday sewing we’ve gathered together a variety of projects, from 
environmentally-friendly gift-wrap (page 16) and pretty embroidered ornaments 
(page 10) to embellished placemats (page 12) and a seasonal mantel cloth  
(page 26). There’s also a calorie-free stitch recipe for embellishing your holiday 
projects (page 29).

Several small projects in this issue are perfect for gift-giving. For the traveler there’s 
an easy-to-locate luggage tag from ReadyMade (page 31), and the stitchers on your 
gift list will love the handy sewing caddy from Kay Hickman (page 14). Any woman 
would adore the lovely lingerie bag featuring large-scale embroideries created on 
the BERNINA 830 (page 18). And to preserve your holiday memories, use the new 
version 6 BERNINA Embroidery Software to create a multi-media commemorative 
quilt block or scrapbook page (page 8). 

Garment sewers are sure to love a fancy party dress designed by combining two 
simple patterns included in My Label 3D Fashion Pattern Software (page 33). Plus, 
Linda Lee of Project Sewing Workshop gives us tips on hemming knits (page 25). 

Last but not least – we have something brand new for this issue – Sarah Caldwell 
introduces us to the many uses for the new the BERNINA CutWork tool, available at 
your local BERNINA store later this fall (page 34)! 
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Baskets
By Alex Anderson

Finished Size: 54" x 54"
Finished Block Size: 6" x 6"

Machine quilted by 
Paula Reid. 

Baskets
Here’s a pretty quilt featuring the ever-
popular basket block. Turning the blocks 
on their sides in the even-numbered 
horizontal rows creates an interesting 
secondary pattern. You will need to make 
41 of the basket blocks and pay careful 
                      attention to the block 
                        positioning in each row to 
                         duplicate the look. 

                      Fabric Requirements
                                     Yardage is based on a 42" of 
                                       usable fabric width. The 
                                        following instructions give 
                                         the total yardage needed to 
                                           complete your quilt.

                                            • Assorted fabrics (lights, 
                                             mediums, and darks):  
                                              33/8 yards for baskets 
                                               and background
                                                 • Inner border: 1/3 yard
                                                  • Outer border and 
                                                    setting triangles: 
                                                     15/8 yards
                                                      • Backing: 31/3 yards
                                                       • Binding: 3/8 yard
                                                         • Batting: 58" x 58"



Alex Anderson
My love affair with 
quiltmaking began in 
1978 when I completed 
a Grandmother’s Flower 
Garden quilt as part of my 
work towards a degree 
in art from San Francisco 
State University. Little did 
I know that quilting would 

become a life-long passion! Over two decades 
later I am still in love with quilting and all that 
surrounds it. From authoring books, designing 
fabric, working with BERNINA of America as 
National Spokesperson, to hosting Simply Quilts 
on Home and Garden television, quiltmaking 
has allowed me to stretch and grow in areas 
beyond my wildest dreams. Visit my website: 
alexandersonquilts.com. 
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Basket Blocks Assembly
For each basket block, cut the following pieces  
(for a total of 41 blocks).

Cutting
Basket
A: �Cut one 53/8" square and cut it in half diagonally.
B: �Cut one 23/8” square and cut it in half diagonally. 

Flowers
C: Cut two 23/8” squares and cut them in half diagonally.

Background
C: Cut three 23/8” squares and cut them in half diagonally.
D: Cut two 2" x 3½" rectangles.
E: Cut one 37/8” square and cut it in half diagonally. 

Block Assembly
Follow the diagrams as shown for piecing sequence.  
Press the seam allowances as indicated by the arrows. 

C

C

D

B

A

E

Quilt Top Assembly
From the lengthwise grain of the 
outer border / setting triangle fabric,  
cut two 5” x 47” strips for the top and  
bottom outer borders and two 5” x 56” strips 
for the side outer borders. Set aside.

From the remaining fabric:
- �Cut four 9¾” squares and cut them in half diagonally  

twice for the 16 side setting triangles.
- �Cut two 51/8” squares and cut them in half once diagonally for the 

4 corner setting triangles. 

Lay out your blocks as shown on the following page. Note that 
they are set on point and that the basket position changes in the 
even-numbered rows.

Join the pieced blocks and side triangles in diagonal rows. Press 
the seams allowances in opposite directions from row to row so 
that seams will nest when the rows are joined. Join the rows and 
press the seam allowances in one direction. 
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Quilt Borders
Inner Border
Cut five 1½" x 42" strips. Sew together with bias seams to make one long strip. Measure the quilt top width through the center and cut two 
strips this length. Sew them to the top and bottom edges of the quilt top and press the seam allowances toward the borders. 

Measure the quilt length through the center, including the inner borders just added, and cut two strips this length. Sew to the remaining 
edges of the quilt top and press the seam allowances toward the borders. 

Outer Border
Measure the quilt top width through the center, including the inner borders. Trim the 5" x 47" outer border strips to this length and sew to 
the top and bottom edges of the quilt top. Press the seam allowances toward the inner borders.

Measure the quilt length through the center, including the outer borders just added. Trim the remaining outer border strips to this length and 
sew to the remaining edges of the quilt top. Press the seam allowances toward the inner border. 

Good job! Your beautiful basket quilt is ready to layer with batting and backing, baste, and quilt. 
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Create the Embroidery Design
Opening & Saving the File
• �Select File > New or click on the  

New icon.
• �Select File > Save As and save  

the new file as Art Canvas.art. 
• �Switch to Art Canvas mode by  

selecting the tab at the top of the  
work area.

Preparing for Appliqué
• �Select the Object Shapes tool and select the  

Ellipse from the fly-out icons.
• Draw an ellipse by clicking and dragging on the screen. 
• Change the width to 100mm and the length to 130mm.
• Press Enter to activate the changes. 
• Click on the Convert to Embroidery icon.
• Select the Outline button.
• Change the stitch to a blanket stitch.
• �Select the Advanced Appliqué icon, then select Place Fabric & Color in Patches.
• Click on Benartex. Click on the Apple Butter color swatches. 
• �Select the white swatch (568-4; seventh row, second swatch).  

Click on the oval to set the fabric in the appliqué.
• Select Back. Select Close. 

Adding Embellishments
• Right click on the Show Hoops icon.
• �Make sure the Display Hoops box is checked. Select artista 255 x 145 Oval from the  

drop-down menu. 
• Turn off the grid if it is on. 
• Select the Hoop Layout mode by clicking on the tab at the top of the work area. 
• �Select the hoop, then select the Rotate Hoop icon and click two times for a horizontal  

hoop view.

Return to Art Canvas Mode
• Click on the Object Shapes tool and select the Star. 
• Create a few random stars of varying sizes around the oval shape. 
• Click on one of the stars two times to get the rotation handles.
• Right click and drag on a star, then select Copy Here from the drop-down menu. 

Expand your creativity 
– try something new! 

Print a photo onto fabric 
using your inkjet printer, 

then incorporate your 
printed photo into a fun 
embroidered quilt block. 
Or try a combination of 
fabric and paper – use 

an existing photo for the 
appliqué and create a 
mixed media project. 

Because BERNINA 
Version 6 Embroidery 
Software now includes 

CorelDRAW Essentials 4,  
artwork techniques 
are amazingly easy. 

Try combining a variety 
of different media – 
combine images with 
stitched embroidery, 
embellish fabric or 

paper, or create with 
thread and ink. Dive in 

and give it a try! 

Photo 
Quilt Block

Scrapbook Pageor

Photo 
Quilt Block

Scrapbook Page
By Amanda Whitlatch
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• �To move a star, click in the center and drag.
• �To delete a star, select it and then press the 

Delete key.
• �Select the Select Graphic Object tool. Hold the 

Shift key and click on each star. Choose a blue 
color chip from the right side of the screen to add 
color to the stars. 

• �Create one large star shape and color it yellow.
• �Select the large yellow star; right click on it and 

select Properties from the drop-down list. 
• Click on the Star tab.
• �Change the Number of Points to 

12 and the Sharpness to 64. Note: 
You can also change these values 
using the Property bar.

• �Add spirals by selecting the 
Object Shapes tool and then 
selecting the Spiral shape from 
the fly-out menu.

• �Click on the Select Graphic Object 
icon and draw a rectangle 
around the stars and spirals.

• �Select the Convert to 
Embroidery tool.

• �Move the stars and spirals as needed to fit within 
the hoop boundaries. 

• �The outlines around the shapes and the filled 
areas are not grouped, so use bounding boxes 
and select the Group icon prior to moving the 
objects. 

Editing the Fills
• �Click on the Color Film icon.
• �Hold down the Control key and select the blue 

color chip and then the yellow color chip.
• �Select the Ripple Fill icon.     

Note: You cannot apply Ripple to overlapped 
objects because they are grouped. These 
objects must be broken apart for Ripple to be 
applied. 

Add Lettering
• �Right click on the Lettering icon.
• Type 
“Celebrate” in 
the window.
• �Use the 

dropdown 
arrow to preview your lettering.

• �Select Speedy. Enter 25mm for the height and 
50% for the width.

• Click OK.
• �Follow the prompts on the Status Bar and click 

on the screen to activate your lettering.
• Move the lettering as desired.

Save the File
• Click on the Save icon.
• �Click on the Write to Machine icon to send the 

design to your embroidery machine  

or USB stick. 

Stitch a  
Photo Quilt  
Block
Select your photo 
and print it on a 
fabric sheet using 
your inkjet printer. 
We recommend 
Printed Treasures fabric 
sheets (follow the package instructions). 

Hoop your background fabric with one layer of OESD Heavyweight  
Tear-Away Stabilizer. 

Stitch the appliqué placement line on your hooped, stabilized fabric.

Lightly spray the back of the photo fabric with 101 Basting Spray. Place the 
printed fabric photo in the desired position, using the stitched placement line as a 
guide. Smooth the photo into position. 

Stitch the cutting line. Cut away the excess fabric from around the outside of the 
stitching, leaving approximately 1/8" of 
fabric outside the stitched line. 

Stitch the tack-down stitching. Stitch the 
blanket stitch outline.

Complete the embroidery using the 
desired colors, and then carefully remove 
the tear-away stabilizer. 

Stitch a Scrapbook Page
Hoop one layer of OESD Stabil Stick Tear-Away Stabilizer. 

Gently score the stabilizer and remove the top layer, revealing the sticky surface 
of the stabilizer.

Center the background paper or cardstock on the sticky surface and gently 
smooth into place.

Stitch the placement line. Position the fabric or paper photo and smooth it into place. 

Stitch the cutting line. Cut the excess fabric or paper 
from around the photo, leaving 
approximately 1/8” 
outside the stitched 
cutting line. 

Stitch the tack down 
stitching. Stitch the 
blanket stitch outline. 

Complete the embroidery 
using the desired colors, 
and then carefully remove 
the tear-away stabilizer.
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Step 1: Embroidery

Draw horizontal and vertical lines through the center of one of the cocktail napkins 
using a disappearing-ink marking pen. 

Hoop a layer of sticky-back stabilizer, paper side up. Score the paper and remove it 
to expose the adhesive. 

Attach the hoop to the machine. Center the napkin in the hoop with the needle at 
the marked center. Make sure it is straight and smooth out any wrinkles. 

Embroider design Scallop 102 from Michelle’s “Holiday Elegance” collection in the 
center of the napkin.

Remove the hoop from the machine. Clip all threads and remove the stabilizer. This 
is the front of the ornament. 

By Michelle Griffith

Supplies
• �Two cocktail napkins at least 6” square 

(source: Wimpole Street Creations, 
www.wimpolestreet.com) 

• Sticky-back stabilizer
• Lightweight Tear-Away stabilizer
• Medium embroidery hoop
• Embroidery Foot #15
• Isacord embroidery thread:
    - Moss Green #5934
    - Caper #6133
    - Bordeaux #2123
    - Heather Pink #2152
    - Parchment #0640
    - Hyacinth #1755
    - Palomino #0822
• Four ½"-diameter gold buttons
• 1 yard 1/16"-wide gold ribbon
• 1 yard 1/8"-wide burgundy ribbon
• Disappearing-ink marking pen
• Ruler 
• Embroidery scissors
• Large-eye tapestry needle or bodkin
• Polyester stuffing
• �Michelle’s Designs “Holiday Elegance” 

collection #3747D
• Embroidery system
• EZ Glitzer and crystals (optional)

OrnamentS

Holiday 
  EleganceHoliday 
  Elegance
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Michelle Griffith of Michelle’s Design offers this quick and easy    
       ornament for your holiday decorating. The embroidery design is 
           from the “Holiday Elegance” design collection, a Designer 
            Exclusive from Brewer Quilting and Sewing Supplies.

                  Note: For the back of my ornament I thought it would be fun to add a 
                 holiday saying. You could also put the date and year. 

                 Using your embroidery system or BERNINA Embroidery Software, 
               design your saying using your favorite alphabet style.

              To embroider the back, mark the other cocktail napkin with vertical 
             and horizontal lines as above. 

         Embroider the design in the center of the two marked lines. 

            Remove the hoop from the machine, clip all threads, and remove  
           the stabilizer.

      Step 2: Decorative Stitching

   Place a layer of Lightweight Tear-Away stabilizer under the front of 
   the ornament. 

Select a decorative stitch from your machine. Thread your machine  
with decorative thread in the needle and bobbin thread in the  
bobbin. Sew decorative stitching around the outer edge of the  
cocktail napkin.

Clip threads and gently remove the stabilizer.

Step 3: Buttons and Ribbon

Sew one button at each corner of the ornament front. 

Thread a large-eye tapestry needle or bodkin with 1/16"-wide gold ribbon. Place the 
two napkins wrong sides together. Starting at the upper right corner, weave the 
ribbon through the holes in the napkin that are nearest to the inside edge, stopping 
about 2" before you reach the starting point so that you can add the stuffing. 

Step 4: Finishing Touches

Stuff your ornament and continue to close up the napkin with the gold ribbon. Tie 
it off at the back. 

Again starting at the upper right corner, weave 1/8"-wide burgundy ribbon beside 
the gold ribbon, through the next set of holes. Tie it off with a pretty bow in the 
back. 

Twist gold ribbon around the buttons and tie the ends to make sure they are 
secure. 

Add crystals to the design if desired.

Michelle Griffith is a 
well-known author, 
pattern designer, 
embroidery design 
specialist, and 
sewing instructor. 
Her attention 
to detail makes 
Michelle’s projects 
and collections 

very special. Her love of sewing and 
embroidery shine through her creations, 
and creating projects from Michelle’s 
patterns is truly a joyful experience. You 
can typically find Michelle working in her 
Southern California office creating new 
projects.  She also attends trunk shows 
and trade shows across the country. She 
loves interacting with customers and 
sharing their enthusiasm. Her designs are 
sure to tickle every sewer’s fancy.
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Have fun making these placemats utilizing your BERNINA accessory feet. 
Personalize them to suit any holiday or décor. I used pintucks, circular 

embroidery, bias binding, and machine embroidery to personalize 
and embellish these placemats. Fast and easy, they make 

up in no time at all – it won’t take long to make one 
for every guest invited to your next holiday 

dinner. And, you could use the same 
techniques to make a matching 
table runner – just change the 

fabric dimensions for a customized 
runner to fit your table! 

Cutting
Cut two 17½" x 13½” rectangles from 

both the center fabric and the fusible fleece.
Cut two 22½” x 17½” rectangles from both 

the backing/border fabric and the Décor Bond.
Cut the fat quarter into 1"-wide true-bias strips.

Instructions
Version 1 Only: Attach a Pintuck Foot to the 

machine and insert an appropriately sized Double 
needle. Stitch three pintucks across the upper left and 

lower right corners of the center rectangle. 

By Linda Wenturine

Supplies 
(makes 2 placemats):

• ½ yard of fabric for the placemat centers
• ½ yard of fabric for backs and borders

• �1 fat quarter (18" x 22" piece of fabric) for  
1"-wide bias binding

• ½ yard of Pellon® Décor Bond 
• ½ yard of Pellon® Fusible Fleece

• OESD LightWeight Tear-Away Stabilizer

Tools
• �Quilt in a Day® Flying Geese Ruler (either size will work)

• Edgestitch Foot #10/10C
• �Open Embroidery Foot #20/20C (placemat version 2 only)

• �Pintuck Foot #30, #31, #32, or #33 and appropriate Double needle 
(placemat version 1 only)

• Patchwork Foot with Guide #57
• �Circular Embroidery Attachment #83 (placemat version 2 only)

• �Bias Binder Attachment #84 (26-30mm) and Foot #94
• Embroidery system (placemat version 1 only)

Borders
Bias Bound
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Version 2 Only: Place two layers of LightWeight Tear-Away stabilizer under the center rectangle. 
Use Circular Embroidery Attachment #83 and Open Embroidery Foot #20/20C to sew decoratively 
stitched circles as desired. For an appliquéd circle, position appliqué fabric on the center rectangle, 
and then straight stitch around the outer edge of the circle using the Circular Embroidery Attachment. 
Carefully trim the excess fabric from outside the stitched line. Satin stitch over the stitching to enclose 
and finish the raw edge. Add decorative stitching as desired.

Both Versions: Attach the fusible fleece to the wrong side of the center fabric.

Version 1 Only: Embroider the desired holiday phrase in the middle of the center rectangle.

Trim the center piece to measure 13" x 17".

Attach Décor Bond to the wrong side of the backing/border fabric.

Place the wrong side of the center fabric against the wrong side of the backing/border fabric. Make sure that the center fabric piece is 
aligned exactly in the center of the backing/border fabric piece. Pin in place. 

Baste the center fabric with a zigzag stitch (width = 3mm, 
length = 3mm) close to the outer edge.

Trim all four sides of the backing/border piece 2" beyond 
the edge of the center piece. 

Using bias seams, join the 1" bias strips together to make 
one continuous strip. Trim the seam allowances to ¼" as 
needed and press them open. 

Attach Bias Binder Attachment #84 and Foot #94 to the 
machine. Sew the bias binding to the RIGHT side of the 
backing/border piece, one side at a time.

Trim the bias even with the edges after each side is bound.

With the right 
side of the center 
facing up, lay 
the flying geese 
ruler on each 
corner with the 
right angle line on 
the corner of the 
center fabric. Cut 
the angle across 
so that you have a ¼"-wide seam allowance beyond the 
corner point.

Fold the cut corner edges right sides together. Pin and sew 
a scant ¼" seam, using Patchwork Foot with Guide #57 
and backtacking at each end. 

Trim the corner at an angle.

Press the corner seam allowances open.

Fold the corners over to the front of the center piece. Press.

Stitch-in-the-ditch along the outer edge of the bias binding 
using Edgestitch Foot #10/10C.

Borders
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Cutting
• For the caddy base, cut two 8" x 18" rectangles from the fat 
quarter
• From the fat quarter for the binding and lining, cut the following 
pieces:
    - Four 2¼" x 18" strips for binding (cut parallel to selvage)
    - One 3" x 8" rectangle for the pincushion accent
    - Two 7½" x 10" rectangles for the pocket lining
• �From the fat quarter for the embroidered pocket, cut two  

11" x 15" rectangles
• From the remaining fat quarter, cut one 11" x 15" rectangle 

Embroider the Pincushion
• �Use Explorations software to create a scissors border as directed 

in the sidebar. 
• �Use 101 Quilt Basting Spray to adhere two layers of Ultra Clean 

& Tear together. Spray the top layer with 101 and adhere to the 
wrong side of the 11" x 15" rectangle for the pincushion. Hoop all 
three layers as one.

• �Attach the hoop to the machine and embroider the scissors 
border.

• �Remove the hoop from the machine and the fabric from the 
hoop.

• �Gently tear away the excess stabilizer from the back of the 
project and trim the embroidered design to a 4" x 9" rectangle, 
keeping the design centered.

• Turn under ½" along each long edge and press. Set aside.

Embroider the Pockets
• �Use 101 Quilt Basting Spray to adhere two layers of Ultra Clean 

& Tear together. Spray the top layer with 101 and adhere to the 
wrong side of the 11" x 15" rectangle for the pocket. Hoop all 
three layers as one.

• �Attach the hoop to the machine and follow the instructions in the 
package to embroider the appliquéd shoe design. 

• �Remove the hoop from the machine and the fabric from the 
hoop.

Sewing Caddy

By Kay Hickman
Tabletop

Use this handy caddy featuring designs 
from OESD’s Crafter’s Collection #885 to 
hold sewing utensils and crafting supplies. 
You can use it on your armchair or drape 
it over an easel to use as a tabletop caddy. 
This project features a scissors design 
from OESD Pack #11735 Arts & Crafts 
2 that adorns the pincushion at the top of 
the caddy. Use Explorations Embroidery 
Software to make a border from the 
scissors motif quickly and easily!

Finished size:  
8" x 18" flat; stands  
approximately 8" tall

Supplies
• �OESD Crafter’s Collection #885, “Head 

Over Heels” by Barbra Music
• OESD Pack #11735 Arts & Crafts 2
• Explorations Embroidery Software
• 1 fat quarter for the caddy base
• �1 fat quarter for the pocket lining, 

binding, and pincushion accent
• 1 fat quarter for the embroidered pocket

• �1 fat quarter for the pincushion fabric to 
be embroidered

• �8" x 18" rectangle of FiberForm™ for the 
base

• �Two 7½" x 10" rectangles of lightweight 
fusible interfacing for the pocket lining

• �Two 7" x 10" rectangles of lightweight 
fusible interfacing for the pocket

• �Two yards ½"- to 5/8"-wide ribbon (optional)

• OESD Ultra Clean & Tear Stabilizer
• Isacord Embroidery Thread
• OESD Bobbin Thread
• 101 Quilt Basting Spray
• 606 Fuse & Fix Permanent Adhesive Spray
• Water-soluble marking pen
• Polyester Filling
• Patchwork Foot #37
• Edgestitch Foot #10
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Sewing Caddy

Tabletop

• �Gently tear away the excess stabilizer from the back of the project and trim the 
embroidered fabric to a rectangle that is 7" tall and 10" wide.

• �Follow the manufacturer’s recommendations to fuse interfacing to the wrong side of 
the embroidered pocket. 

• �Attach a zipper pull to the top of the zipper on the heel of the shoe. Then add 
buttons, stitch on ribbon, and decorate the pocket as desired. 

• �Follow the manufacturer’s recommendations to fuse interfacing to the wrong side of 
the pocket lining pieces.

• �Place one 7½" x 10" pocket lining piece along the upper edge of the trimmed 
embroidered pocket piece with right sides together. 

• �Stitch ¼" from the upper raw edges, using Patchwork Foot #37. Wrap the lining 
fabric to the wrong side of the pocket and press in place.

• Repeat for the remaining pocket.

Create the Caddy
• �Spray each side of the 8" x 18" piece of FiberForm™ with 606 Fuse & Fix Perma-

nent Adhesive Spray following the manufacturer’s instructions. Fuse the wrong 
side of the 8" x 18" base fabric rectangles to each side. 

• �Use a water-soluble marking pen to draw a line 8" in from each short end.
• �Turn under ½" at each long edge of the 3" x 8" pin cushion accent and press. 
• �Position the accent piece right side up 

between the two lines drawn on the base 
piece. Allow equal amounts of fabric to 
extend beyond the edges of the base piece.

• �Use Patchwork Foot #37 to stitch the 
band to the base ¼" from the fold line. 

• �Align one long folded edge of the embroi-
dered scissors pincushion piece along the stitching line of the 
accent piece that is already stitched to the base fabric. Edgestitch 
in place using Edgestitch Foot #10.

• �Align the other long folded edge of the embroidered pincush-
ion piece along the other stitched line of the accent piece and 
edgestitch in place. The excess fullness in the fabric will form a 
tunnel. Insert polyester filling into the tunnel. 

• �Make tiny tucks on the ends of the tube and 
pin. Machine-baste the ends in place and 
trim them even with the base.

Attach the Pockets
• �Align one pocket edge with the base 

fabric/FiberForm™ and machine-baste ¼" 
from the raw edges.

• �Align the other edge of the pocket with the 
other edge of the base and machine-baste 
¼” from the raw edges. 

• �Remove the fullness along the bottom 
edge of the pocket by pinning a small tuck on each side. Machine-baste with a 
¼” seam allowance.

• Repeat for the other pocket.

Apply the Binding
• �Use ¼”-wide seam allowances to sew the short ends of the four 2¼” x 18" strips 

together, making one long strip. Press the seam allowances open. 
• �Fold the strip in half lengthwise with wrong sides together and press.
• �Bind the edge using a ¼”-wide seam allowance.

Attach the Ribbon (optional)
• �Cut the ribbon into 18" lengths. Attach to the wrong side of the caddy 3" up from 

the bottom on each side.
• �For optimal stability, place the caddy over an easel when using as a caddy stand.

Create a Border Design with 
Explorations Embroidery 
Software
• �Open Explorations Software. Click New and 

open a New Project.
• �Click the Designs Mode icon. Click Tools > 

Filing Assistant and find the location of the 
scissors design stored on your computer. Click 
and drag the scissors design (NY579) onto the 
Workspace.

• �With the design selected, click on one of the 
outside corner Sizing Handles (solid boxes) 
and reduce the size by approximately 50% to 
1.48 x 0.92. 

• �With the design selected click Tools > Layout 
Wheel. Click the Wreath button and type “5” in 
the dialog box.

• �Left click the mouse to position 
the wreath. 

• �Click on each individual 
scissors design and move them 
into a line. (Do not worry about 
alignment at this point. We will let the software 
do this later.) 

• �Position the scissors 
so that the left edge 
of the left scissor is 
approximately 7" from the right edge of the 
right scissor.

• �To center the scissors border vertically, click 
Edit > Select All. Then click Align > Vertical 
center.

• �To space the designs 
evenly, click Align > 
Space Horizontally.

• �Click on the Workspace to deselect the design.
• �To ensure that the scissors stitch out from 

left to right (and thereby avoid lots of thread 
clipping!), hold down the Control key on the 
keyboard and select each pair of scissors 
individually from left to right. Click Tools > 
Sequence as Selected.

• �To ensure that the design 
will fit inside the hoop of 
your machine, click the 
Hoops Mode icon and 
select the hoop for your 
machine. Notice that part of 
the design is green (the part 
that will fit inside the hoop), 
and the other part is black 
(the part that will not fit inside the hoop).

• �Rotate the hoop to cover 
all parts of the design by 
clicking on the hoop to 
select it, then clicking Edit 
> Rotate Left 45. Click Edit 
> Rotate Left 45 a second 
time.

• �Click the Threads Mode icon to view the 
number of color changes. There are five colors 
in each scissors design, but there are now 25 
color changes. To reduce the number of thread 
changes, click Tools > Stitch Sequence. 

• �Click Save on the General Tools Menu bar 
and you are ready to send the design to a 
file on your computer, or to your BERNINA 
embroidery system via a direct connection or a 
USB stick.
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Supplies
• �Cotton fabrics in solid colors or 

understated patterns
• �Cords, velvet ribbons, 

decorative ribbons, organza 
ribbon

• Angelina fibers
• Embroidery thread
• Craft felt 
• Yarn
• Beads
• BERNINA sewing machine

• BERNINA serger (optional)
• Iron and ironing surface
• Hand sewing needle
• Clear Embroidery Foot #39
• �Decorative Needle Punch 

Accessory Set

• Edgestitch Foot #10/10C
• �Freehand Quilting Foot 

#29/29C or Freehand 
Embroidery Foot #24 or 
BERNINA Stitch Regulator

Finished size: Approximately 12” x 18”

with a 2½"-wide organza ribbon. Cover the edges with braid and sew everything together 
using Edgestitch Foot #10/10C. 

Add rows of decorative stitching as desired using Clear Embroidery Foot #39.

Fold the rectangle in half, right sides together. Stitch the side seams with the serger using 
a four-thread overlock stitch. (Alternatively, stitch with a ½"-wide seam allowance and 
overcast the raw edges together.) Overcast or serge the upper edge and press under 4". 
Secure the hem with a straight stitch.

Cut a 1-yard length of cording. Wrap the cord several times around the neck of the bag.

Every year the piles of post-Christmas 
wrappings and boxes seem a bit higher. 
This year we wanted to show you how you 
can wrap your gifts in an environmentally 
friendly way and give the recipient some 
extra benefit from the packaging. 

All you need for these little bags are some 
fabric remnants, trim, ribbons, and a 
bit of creativity. Let our felted stag, the 
Angelina trim, or the felt flowers inspire you 
to create your own designs. Afterwards, 
these little bags can find a new lease 
on life as containers for craft projects or 
hobby equipment. 

Cutting Instructions
For each bag cut one 13" x 44" rectangle 

Checked Bag
Spread Angelina fibers out on a surface 
measuring approximately 2½" x 14". Iron 
to fuse into a fibrous web as described in 
the manufacturer’s instructions. Lay the 
fused web on the bag fabric and cover it 

Wrap It UpWrap It Up



This article was originally published in 
Inspiration magazine, No. 42, Autumn-
Winter 2008.
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Woolen Flower Bag
Cut strips approximately 8" long and 1/8" wide from the craft felt. Cut yarn into 8" lengths. Combine colors as desired 
and twist into spirals. Work flowers into the fabric one after another using the Needle Punch Accessory. Tip: Place a 
strip of water-soluble stabilizer over the yarn so the ends won’t get caught in the needles. After careful felting,
the stabilizer can be lifted off without leaving any residue. 

Fold the rectangle in half, right sides together. Stitch the side seams with the serger using a four-thread 
overlock stitch. (Alternatively, stitch with a ½"-wide seam allowance and overcast the rawedges  
together.) Overcast or serge the upper edge and press under 4". Secure the hem with a straight stitch.

Make four ¾"-long buttonholes in each side of the bag, near the lower edge of the hem allowance. 

Cut a 1-yard length of ¼"-wide ribbon. Sew narrow velvet ribbons to the right and left sides of the ribbon 
with Edgestitch Foot #10/10C and a blindstitch or vari-overlock stitch. (Alternatively, use a 1-yard length 
of cord.)

Weave the ribbon through the buttonholes and tie into a bow.  

stag bag
Cut out pattern piece from brown craft felt. Attach the Needle Punch Accessory to the machine and felt the 
stag’s head into the fabric. 

Attach a free-motion foot to the machine and free-motion embroider the outline of the chin and the inside of the ear with a few stitches.  
Sew on beads for the eyes and muzzle. 

Attach Edgestitch Foot  
#10/10C to the machine.  
Sew on trims and ribbons  
as desired under the stag’s  
head.

Fold the rectangle in half, right sides 
together. Stitch the side seams with the 
serger using a four-thread overlock stitch.  
(Alternatively, stitch with a ½”-wide seam 
allowance and overcast the raw edges together.) 
Overcast or serge the upper edge and press under  
4”; secure the hem with a straight stitch. 

Embellish the upper edge with a decorative stitch using  
Clear Embroidery Foot #39.

Cut a 1-yard length of cording. Wrap the cord several times  
around the neck of the bag; tie the ends together.
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se your BERNINA 830 to combine 
imported stitches with exclusive Susanne 
Müller designs, creating an endless 
embroidery design to embellish this lovely 

lingerie bag. It’s the perfect place to store all your 
“pretty little things.” Make one for yourself or to give 
to a friend. The closed bag measures 11" by 13".

Create the Floral Center Pattern
Select stitch #202 and import into embroidery. To import into 
embroidery, select the stitch and touch the module soft key icon; this 
stitch is then moved to your My Designs folder.

Open the My Designs folder and select the stitch.

Select the Oval Hoop.

Duplicate and Mirror Image 
(left/right) the stitch.

Move the second pattern 
below the first pattern so 
the patterns connect.

Select Endless embroidery for two pattern repeats.

Turn off the reference 
marks and press check 
to confirm.

Duplicate the pattern 
string, and then delete 
the original.

Save the duplicated 
pattern string.

Lovely 
  Lingerie 
Bag

By Susan Fears

Part 1: �Create the Endless  
Embroidery Pattern

U

Note: With the new  
830 update, it is 
suggested that a 
9mm sewing foot 
be attached to the 
machine when  
importing 9mm 
stitches into 
embroidery; 
however, use the 
embroidery foot 
for embroidering 
the patterns.
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Create the Border Pattern 
Select stitch #172 and touch the module soft key to place the stitch 
in the My Designs folder. Select the New Motif icon and import the 
stitch into embroidery.

Select the Oval Hoop.

Select Endless embroidery and adjust to 5 pattern repeats.

Turn off the reference 
marks and press check to 
confirm.

Duplicate the design, and 
then delete the original 
pattern string.

Save the duplicated pattern string.

Combine the Border and Floral Center Patterns
Select the New Motif icon and select the Border Pattern from the My 
Designs Folder.

Move the border to the right side of the hoop.

Activate the Grid. Use the Zoom function as needed for alignment.

Duplicate and Mirror Image (left/right) the border, then move the copy 
to the left side of the hoop. 

Select the Retrieve icon to select all and touch the Move icon to 
center the design.

Select the Add icon to add the Floral Center (it will come in centered).

The Floral Center is shorter than the Border. To make them the same 
length and stitch as endless embroidery with no gaps, find the length 
of the border. Use the Retrieve icon to select the Border and note the 
height measurement displayed on the screen. Select the Floral Center 
pattern and select the Rescale Motif Width and Height icon; use the 
stitch length multi-function knob to change only the height of the 
pattern to match the border height. In this case, rescale the height to 
119%.

Select the Jumbo hoop. 
Use the Retrieve icon to 
select all, and then rotate 
the entire pattern 90 
degrees. 

Save the pattern. Note the 
width measurement of the 
design.

Tip: As stitches are arranged on screen, the centering 
icon shows the beginning point of each stitch. Using this 
information, arrange the beginning point at the ending point of 
the previous pattern for uninterrupted stitchouts

Create the Next Pattern Combination
Select the New Motif icon and open Susanne Müller design #17.

Select the Jumbo Hoop.

Duplicate the motif and mirror image (top/bottom) the second 
design.

Move the design next to the first motif so they are horizontal.

Use the Retrieve icon to select all, and then center the design. 

With everything selected, use the Rescale (proportionately) icon 
to adjust the width of this design until it matches the width of the 
previous pattern combination (approximately 79%).

Save the pattern. We will refer to this pattern as the Susanne 
Müller group design.

Put it All Together
Select the New Motif icon, open My Designs, and select the first 
pattern combination.

Select the Jumbo Hoop and activate the Grid.

Move the design to the upper third of the hoop.

Duplicate and center only the second design (by touching the 
Move icon).

Move the design to the lower third of the hoop about eight grid 
spaces away from the first one. Using the knobs will prevent 
the stylus or finger from selecting other parts of the design 
inadvertently.

Use the Retrieve icon to select all, and then touch the Move icon 
to center the design.

Use the Add Icon 
to add the Susanne 
Müller group design. It 
will come in centered.

Save the design.

Touch Endless Embroidery. Turn on the Center Side Right 
Reference Mark and check to confirm.

The design is ready to be stitched. Be sure to activate the Color 
Resequence icon to group the color changes.

For instructions on completing the bag, visit www.berninausa.com 
> The BERNINA 8 Series > Lovely Lingerie Bag - Part 2.

Tip: To make individual strings of the same length, use the 
Retrieve icon to select one pattern – note the length from the 
measurement on screen, then change the second pattern 
to match its size. Use Rescale (proportionately) or Rescale 
Motif Width and Height to adjust the pattern to the needed 
dimensions.
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This beautiful, 
intricate 
design makes 

an impressive 
quilt, and Circular 

Embroidery 
Attachment #83 

makes it so easy and 
fun to stitch!
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                                  					        Quilt Top Construction
							            � �Cut a total of 32 (or more) 6½" x 6½" 

squares from the selected fabrics, 
making sure you have a variety of 
lights, mediums and darks.

							            �Arrange the squares to create two 
quilt tops, one darker than the other, 
with four squares in each of four 
rows. For example, where you have a 
dark green square in the first pieced 
top, use a lighter green square in the 
same location of the second top. You 
need 16 squares for each top. 

							            Stitch the squares together in rows 
						           using a Quilting needle and Patchwork

					          Foot #37 or Patchwork Foot with 
Guide #57 (¼"-wide seam). Press seam allowances open.

Layer the two quilt 
tops, both right side 
up, with the darker 
version on top. Baste 
together, carefully 
matching seams.

Using a compass, draw 
a variety of circles on 
freezer paper and cut 
them out. The sample features circles with diameters of 4½” to 8½”.

Place the freezer-paper circles on the quilt top, waxed side down, in the desired 
arrangement. Note that some circles should extend past the quilt-top edges. Use a dry 
iron to secure the circles to the quilt top.

Place 
Tear-Away 
stabilizer 
under the 
quilt top, 
making sure it 
extends under 
the circles that 
go beyond the 

quilt-top edges.

Supplies
• �¼ yard each of 5-6 different value- 

gradated fabrics (sample features  
“Gradations” by Benartex)

• �1 yard backing and binding fabric

• 26” x 26” square of batting

• �Sewing and decorative threads to 
match and/or contrast with fabrics

• �Decorative bobbin-drawing threads 
(sample features gold Superior “Razzle 
Dazzle”)

• Freezer paper

• �OESD Medium- to Heavyweight  
Tear-Away stabilizer

• 505 Quilt Basting Spray

• Drawing compass

• �#90/14 Topstitch needle (for decorative 
threads)

• �#75 Quilting needle (for piecing)

• �Patchwork Foot #37 or Patchwork Foot 
with Guide #57 

• Open Embroidery Foot #20/20C

• �Free-motion Quilting Foot #29/29C or 
BERNINA Stitch Regulator

• �Circular Embroidery Attachment #83

• �Black-Latch Bobbin Case or extra  
bobbin case
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Stitching Circles
Attach Circular Embroidery Attachment #83 to the machine, following the instructions included in the box. 

Align the center of one of the freezer-paper circles with the center pin on the 
Circular Embroidery Attachment #83 and top the pin with the cover. Adjust the 
attachment until the needle is close to the edge of the circle. Using a short stitch 
length (1.5mm), stitch around the circle.

Some circles (A, B, and C in the sample) have a second interior circle. After 
stitching the first circle, choose a smaller diameter for the second circle and offset 
the center point. Stitch the second circle with Circular Embroidery Attachment #83. 
Remove basting as needed. 

With sharp pointed scissors, trim away the circle centers as close as possible to the stitching. For Circles A, B, and C, cut away the fabric 
between the two circles so the lighter quilt is exposed to create the effect of radiance. 

Decorative Stitching
Select one of the circles on the quilt top and position it on Circular Embroidery 
Attachment #83, aligning the center and the attachment pin (there will be a pinhole 
in the stabilizer at the circle center). Adjust the attachment until the needle is lined up 
with the stitching.

Set up the 
machine 
with a 
Topstitch 
needle and 
decorative thread. Choose a dense decorative stitch and sew over 
the straight stitching. Repeat for all circles.

Add more decorative stitch circles, if desired.
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Bobbin Drawn Circles
Using the compass, draw several concentric 
circles on freezer paper. Iron freezer paper circles 
to the back of the quilt, on top of the stabilizer.

Wind a bobbin with heavy thread such as “Razzle 
Dazzle” and insert the bobbin into the extra bobbin 
case. Adjust the bobbin case tension until the 
thread pulls freely. 

Turn the quilt topside down and place it on Circular 
Embroidery Attachment #83, aligning the center of 
one freezer-paper circle and the attachment pin.

Stitch the circle with a long straight stitch, tying off 
the thread tails. Repeat as desired.

Quilting
Remove the excess freezer paper, stabilizer, and 
bottom quilt top.

Use 505 Quilt Basting Spray to baste the top, 
batting and backing together.

Free-motion quilt around the circles using  
Free-Motion Quilting Foot #29/29C or the 
BERNINA Stitch Regulator. Alternatively, use Open 
Embroidery Foot #20/20C and straight stitching.

Add decorative free-motion stitching as desired.

Finishing
After quilting, square up the quilt and sew on the 
binding using your favorite technique.

Using Open Embroidery Foot #20, couch a line of 
“Razzle Dazzle” just inside the edge of the finished 
binding.

Libby Lehman, a native Texan, fell in love 
with quilting while pregnant. In between 
changing diapers and naps, Libby made 
traditional quilts by hand. She discovered 
art quilting and has never looked back. 
Today Libby is known for her innovative 
and color-splashed art quilts. All made on 
a BERNINA, of course!
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Quilting Rule No. 1:  
You must put a binding on your quilt.
New Truth: Not so. Art quilters are finishing quilts by 
double folding the raw edges to the back and tacking them 
down, applying fringe to the edges, or couching them 
closed with decorative threads.

Quilting Rule No. 2:  
The back of your quilt should be as 
beautiful as the front.
New Truth: Today’s art quilts are meant to be hung on  
a wall, so the backs don’t matter as much as they did in 
the past.

Quilting Rule No. 3: 
You must start from scratch.
New Truth: Who says? You can embellish store-bought 
items, such as jackets, jeans, shirts, tablecloths and tote 
bags, or machine-quilt whole-cloth designs – just for the 
fun of it!

Quilting Rule No. 4: 
You must use batting in your quilt.
New Truth: Many art quilters use nothing at all; others 
sandwich fleece instead of batting for a flatter look. Some 
quilters, including landscape artist Jo Diggs, even frame 
their pieces instead of finishing them the traditional way.

Quilting Rule No. 5: 
You should only use cotton fabrics in  
your quilts.
New Truth: Wrong again. Anything goes – silk, tapestry 
fabrics, Angelina fibers, even metal and paper! Mixed  
media is one of the hottest trends of the day, so feel free  
to experiment. 

By Nancy Monson

Breaking
the Quilting 

  Rules

Breaking
Quilting 
  Rules

Ding dong! The quilting police are dead! And 
if they don’t care whether your quilts follow 
some antiquated rules or not, why should 
you? Just peruse books such as Sandi 
Cummings’ Thinking Outside the Block and 
Susan Carlson’s Free-Style Quilts and you’ll 
find lots of projects that push the envelope on 
the traditional quilting “rules and regulations.” 
There are even patterns for people who can’t 
be bothered to make points or prefer off-center 
blocks and shapes. Meanwhile, art quilters are 
creating unique, mixed-media pieces that go 
way beyond the old concepts of quilting. 

Here, then, 10 quilting rules that were just 
made to be broken… 

Quilting Rule No. 6: 
All edges must be neatly finished.
New Truth: It’s okay to appliqué and leave the edges raw. In fact, raw edges 
rule in abstract and collage-type quilts. Fuse away and let the fringe fly!

Quilting Rule No. 7: 
Quilts must be quilted.
New Truth: Quilts can be tied, appliquéd, fused or glued. And there’s 
always the option of doing the piecing yourself and sending the quilting out 
to a long-arm quilter to complete. 

Quilting Rule No. 8: 
You must finish what you start.
New Truth: Some projects don’t deserve to be finished – you’ve outgrown 
them or grown tired of them. Or they may best serve you as exercises, 
rather than finished pieces. For example, I made a dramatic abstract quilt 
recently with hand-dyed fabrics. All went well until the quilting part, when 
the permanent fusible I’d used by mistake didn’t play well with my machine. 
What once was a masterpiece is now the first step in a series. Bad quilt!

Quilting Rule No. 9: 
You must make a quilt to be a quilter. 
New Truth: You can create the trading cards and postcards everyone’s 
collecting, as well as collages, garments and bags. Personally, I’ve started 
knitting with fabric because it offers great portability, it’s forgiving (love 
those huge knitting needles), and I get to use all my favorite batiks. (Try 
Cyndy Rymer’s book Fast, Fun & Easy Fabric Knitting for projects). 

Quilting Rule No. 10: 
You must follow pattern directions.
New Truth: Going beyond the pattern is a sure sign of creative 
development, so use the directions as a guide and make your quilt 
uniquely yours. And remember: You quilt for your enjoyment, not to create 
another chore on your to-do list. It’s your project, so do whatever you want 
and banish those quilting rules for good. 

Nancy Monson is a quilter and crafter, as well as the 
author of Craft to Heal: Soothing Your Soul with Sewing, 
Painting, and Other Pastimes, which details the mental, 
physical and spiritual benefits of pursuing a hobby you 
love. Visit her blog at http://crafttoheal.blogspot.com. 
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As part of Project Sewing Workshop’s wardrobe concept, the Trio  
T-shirt is a “must-have” basic garment. Wear it with jeans or pair it  
with the Trio Top and Pants; try it under the Mimosa Top with the  
Lotus Skirt; or pair it with the Valencia Jacket. All of these are  
available in kits in the Project Sewing Workshop program. 

As with all t-shirts, a knit fabric is required. Knits can be tricky, especially when stitching hems.  
Since the crosswise grain of a knit is the direction with the most stretch, the fabric is apt to  
grow as you sew a crosswise hem, resulting in little peaks (blips) along the way.

But – there is great way to solve this problem! Here’s how to do it:
1. �After cutting out your t-shirt, immediately press the hem allowances of the body and sleeves  

in place. This is just a memory crease for later use.

2. �Unfold the hems and sew strips 
of ½"-wide Fusible Knit Stay Tape 
(available at your local Bernina 
dealer) to the wrong side of the hem 
edges with the fusible side of the 
tape facing up. Sew about ¼" from 
the raw edge.

3. �Do not press the hems in place yet. Continue on with the process of constructing your t-shirt. After  
the side and sleeve seams have been sewn, press the body and sleeve hems in place. As you topstitch 
your hems, the fusible tape will keep the fabric from creeping and stretching and you will have perfectly 
flat hems.

Options for Topstitching Hems:  Straight Stitch, Double or Triple-Needle Stitch, Serger Cover Stitch

Perfect Hems in Knit T-shirts
By Linda Lee
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Dress your mantel in a covering of sweet golden bells strewn across a snowy 
white mantel scarf. It’s the perfect setting for your most cherished holiday 
ornaments. Make one for yourself and for each of your favorite friends. It’s easy 
because the quilting is done in the embroidery hoop. 

I’m one of the new breed of quilters. I use my embroidery machine to enhance 
my quilts, both by adding luscious embroidery designs and by using nouvelle 
embroidery-machine-related quilting techniques. Recently I’ve been using a 
“quilt-as-you-go” technique to join the squares I’ve quilted in the embroidery 
hoop. It’s really easy and provides excellent results. You can make this mantel 
scarf in less than a day.

Stitch the Embroidery Designs
For each of the designs, hoop stabilizer, batting, and one piece of the white 
fabric. 

Stitch all colors in the design except the last one (the last color is the stippling). 

Remove the hoop from your machine but DO NOT REMOVE THE FABRIC AND 
STABILIZER FROM THE HOOP!

Turn the hoop over so you are looking at the back of the stitchout. Lay a piece 
of white fabric over the stitching so that it reaches to the edges of the hoop. 
Use masking tape to secure the fabric and hold it in place around the edges of 
the back of the hoop.

Replace the hoop in the machine and stitch the last color.

Repeat the above steps until you have stitched six bells, the two end pieces, 
and the design with the words “Joyeux Noelle.” You now have nine quilted 
blocks.

Bring on the Bells
By Bobbi Bullard

Supplies
• �The Bell Choir embroidery designs from 

www.bullarddesigns.com

• White pima cotton or similar fabric:
    - �Enough to hoop a 5" x 5¼" design  

16 times 
    - �Enough to hoop a 5.4" x 8" design  

2 times

• Gold silk dupioni for sashing: 
    - �Eight 1" x 6½" strips for front sashing
    - �Eight 15/8" x 6½" strips for back 

sashing; fold each one in half 
lengthwise, wrong sides together

    - �One 1" by 55" strip for front of top 
sashing

    - �One 15/8" x 55" strip for back of top 
sashing, folded in half lengthwise with 
wrong sides together

    - �One 80"-long strip for binding the 
bottom and sides. Determine cut 
width based on your preferred binding 
method. 

• �Lace: One piece cut to approximately 
55" long; you’ll trim this to the exact 
size after you’ve completed most of the 
construction.

• �Medium- to Heavyweight Tear-Away 
Stabilizer: Enough to hoop 9 times 

• Batting: Enough to hoop 9 times

• �Thread: Assorted gold embroidery threads

• Masking tape

• Rotary cutter, mat, and clear ruler

• �EZ Glitzer and hot fix crystals (size 10ss) 
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Trim the Stitched Blocks
Place your ruler so that the edge is ¼" beyond the edge of the 
stipple stitching on one of the stitched and quilted bell blocks. 
Using a rotary cutter and mat cut away the excess fabric. 
Repeat on the other three sides of the rectangle.

Repeat for the other five bells, making sure the height of all 
finished pieces is the same. 

Trim the stitched and quilted center panel to match the height of 
the bell blocks. 

Join the Blocks
Stack the sashing pieces and embroidered blocks with the 15/8" 
folded-back sashing strip on the bottom (folded edge to the middle), 
the embroidered rectangle in the middle, and the 1" front sashing strip 
on top. Be sure to align the raw edges of all pieces in the stack. In this 
example we’re sashing the left edge so we’ll line up the left edges of 
the three pieces.

Stitch all layers together ¼" from the raw edges.

Press the front sashing piece away from the quilted rectangle. Leave the 
back sashing piece as it was sewn.

Pick up your next quilted rectangle. Turn it over so the back of the 
rectangle is facing you.

Match the left side of the back of the second quilted rectangle to the 
left edge of the top sashing. This will put right sides together.

Using a ¼" seam 
allowance, sew 
the top sashing 
to the second 
rectangle. DO 
NOT CATCH ANY 
OF THE FIRST 
RECTANGLE IN 
THE SEAM!
 
Press the top 
sashing seams 
open on the front of the two pieces. 

Turn the piece over and press the fold of the back sashing over the raw edges. Hand tack the sashing to the rectangle.

Use the method described above to join all of the stitched pieces in the order shown in the photograph on page 28.
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t h r o u g h  t h e  n e e d l e

Award-winning Bobbi 
Bullard has developed 
unique methods 
for individualizing 
garments with 
a variety of 
embellishment 

techniques. She has been entertaining 
and amazing sewing enthusiasts 
for years, teaching around the 
country, inspiring people wherever 
she goes. She has been a leader 
in the embellishment and machine 
embroidery world since 1996. You  
can see more of her work at  
www.bullarddesigns.com.

You can eliminate all hand sewing by 
reversing the process and sewing the 
1” piece of unfolded sashing to the 
back of the quilted rectangle and the 
15/8” piece of folded sashing to the 
front. After you’ve joined the blocks, 
edgestitch the folded edge of the 
sashing to the front of the quilted piece. 
The tradeoff is that the topstitching 
will show on the front of your finished 
piece and the back will not be quite as 
perfect as it would be if it were hand-
stitched.

Add a Supporting Apron
To hold your mantel scarf on your mantel you’ll need an apron, a piece of fabric 
that will lie on the mantel. 

To determine the length of the apron add ½" to the length of the pieced mantel 
scarf. For the depth of the apron, measure the depth of your mantel. If you’re 
making the scarf as a gift and don’t know the depth of the mantel use 6”.

Cut a piece of fabric for the apron measuring the apron length by twice the 
apron depth. 

Fold the apron right sides together and stitch around three sides. Clip the 
corners, and turn the apron right side out. 

Use the same “quilt-as-you-go” method to attach the apron and the top and 
bottom sashing to the pieces you’ve already assembled.

Bind the Edges
Use your favorite method to bind the lower and side edges of the piece using 
the 80"-long piece of gold silk dupioni.

Place the top edge of the lace behind the lower-edge  
binding. Trim the lace to the appropriate length.  
Stitch-in-the-ditch at the edge of the binding  
to hold the lace in place.



This is probably the only fun, calorie-free recipe 
you’ll see for a while. That’s because it’s done on a  
BERNINA sewing machine! You can make your own recipes  
with your favorite decorative stitches.

Some stabilization is always necessary when adding decorative stitching  
to your fabric. Choose your favorite OESD stabilizer and remember to always sew a test  
swatch to see if you are using enough stabilizer to keep the final project flat. The best choice  
will probably be a combination of a cut-away stabilizer such as OESD PolyMesh and a tear-away  
stabilizer such as OESD HeavyWeight Tear-Away, depending on the final use of the decoratively  
stitched piece. Use a temporary spray adhesive such as  
101 Quilt Basting Spray to adhere the layers  
together before stitching.

By Linda White

	 BERNINA model	C enter stitch 1	C enter stitch 2	 Scallop stitch

	
220	

--	
43	

34

	
230	

61	
65	

48

	
240	

79	
88	

58

	
430	

121	
130	

79

	
440	

150	
159	

102

	
450	

145	
152	

88

	
630	

705	
717	

416

	
640	

705	
717	

416

	
730	

705	
717	

416

	
830	

705	
717	

416

• Use a disappearing marker and a ruler to draw a straight line on the fabric where the decorative stitches will be sewn. 

• Attach Clear Foot #34 to the sewing machine. Sew the center row of decorative stitches. 

Helpful Hint: If you can adjust your machine’s motor speed, slow the motor down to a comfortable speed when matching rows and 

stitch patterns. It is easier to sew when pressing your foot control all the way to the floor runs the machine at only half speed.

• �Sew the second row of decorative stitches (the scallop pattern). Align the edge of the 

presser foot with the first row stitched, or attach the Quilting/Seam Guide to the back 

of the foot and use it to keep the second row evenly spaced from the first row. 

• �Select Pattern Begin to start the third row of stitching at the beginning of the first stitch 

pattern. Engage the Mirror Image function so that the third row of stitching will mirror 

the second row. Stitch the third row, spacing it evenly from the center row.

Helpful Hint: When sewing mirrored rows of decorative stitches on the machine, the 

stitches match up better if the rows are sewn in the same direction.

Stacked Stitch Recipe

Holiday Stitches 2

Holiday Stitches 1

Stacked Stitch RecipeStacked Stitch Recipe
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Pattern designed by the editors of ReadyMade





33

i s s u e  3 2

                                         My Label 3D Fashion Pattern Software  
                                          offers you endless possibilities for  
                                           adapting the existing designs to  
                                            create your own design. The  
                                             Fashionista dress shown here was  
                                        created using a pattern manipulation  
                           technique with My Label software. It’s easy!  
                          Just print two patterns and combine them –  
                          then cut the new pattern from your favorite  
                          fabric, and stitch up the dress. You’ll be ready in  
                              no time to make your own stylish statement  
                                 at your next fashion event!

                                         Pattern manipulation can involve  
                                         changing a pattern to create the look 
                        you want; merging a commercial pattern with a 
My Label pattern; or combining two My Label patterns to create 
your own design. 

Create the Fashionista dress by combining the My Label halter 
top with the My Label slip dress. First, print each of the patterns 
using your measurements. (The sample dress was made 
using the default measurements with no alteration of the style 
properties.)

When combining patterns, whether they are two My Label 
patterns or a My Label pattern and a commercial pattern, there 
are certain rules that must be followed. If the patterns are both 
tops, the provision for bust contour must be the same; in other 
words, if the bust contour of one pattern has a dart or a fitted 
princess seam, the other pattern should also have a dart or a 
fitted princess seam. Additionally, the fabric suggestions for each 
pattern should be the same. In other words, don’t mix patterns 

that are drafted for knits with patterns that are meant for woven 
fabrics. 

• �To combine the halter top with the slip 
dress pattern, align the center fronts of the 
patterns. Make sure the waistline of the lower 
part of the dress aligns with the waistline 
of the halter top. Tape the pattern pieces 
together.

• �Blend the two patterns together along the 
side seams using a Fashion Curve Ruler.

• �Repeat this process for the back pattern 
pieces, aligning the center backs of the 
top with the slip dress and matching the 
waistlines.

• �Lay the combined front on the combined 
back and make sure the two blended seams are the same 
shape. Blend the front and the back seams to balance them if 
they are not equal. This is necessary so that the seams will sew 
together smoothly.

• �Cut the fabric using the suggested layout for the halter top. 
Follow the printed instructions for construction of the halter 
top—the dress is just a longer version of the top. Enjoy your 
creation!

Fashionista
By Debbi Lashbrook

Explore the Possibilities

BERNINA aurora 450 Fashionista Limited Edition
Express your passion for fashion with the Limited Edition 
Fashionista, with all the style-savvy features of an 
aurora 450 including a 9mm stitch width! My 
Label 3D Fashion Pattern Software is included  
as a free gift to you, letting you create clothes  
that reflect your style, your shape, and your 
fashion ideas. Available at participating 
BERNINA stores while supplies last. 



You may not be aware that BERNINA International has a new innovations team whose 
sole job is to be on the lookout for wonderful new techniques and products to make 
our lives as creative people so much easier, and therefore much more fun. So when 
they told me they had developed a way to eliminate the hand cutting necessary in 
so many of our sewing projects, I was very, very interested! And I am so excited to 
have been given the opportunity to write this article about a fabulous new product 
from BERNINA – a needle that cuts! Curious? Read on! You’ll want one too! 

The CutWork Tool
The fabulous new tool is actually a small knife that you insert in the machine just like 
a needle. It can be turned manually in four directions. It is used in conjunction with a 
special stitch plate, similar to a straight stitch plate. Use it with the newly developed 
presser foot for cutwork: Echo Quilting and CutWork Foot #44. It has a large see-
through saucer-shaped sole, perfect for moving smoothly over cut layers. 

Simple-to-Use Software
Using the software included with the CutWork Tool, 
it’s easy to create a cut layer in an existing embroidery 
design or in one you’ve created using a picture or 
clipart. You use the tools in the software to indicate 
which parts you want to be cut, and the software 
converts the selected shape into the required cutting 
directions.

When you 
download the file to your embroidery system, you are 
prompted when to manually turn the CutWork needle in one 
of the four directions. Not only are you able to cut, but you 
can also program running stitches, satin stitches, and a net 
fill. There are so many possibilities, and you will find excellent 
instructions in the extensive online manual. You are going 
to love the advanced features of Circular Array to create 
beautiful table mats.

Cut up to Ten Layers in One Go!
Do you hate cutting multiple layers of shapes 
for your quilts? The BERNINA CutWork Tool can 
cut up to ten layers of cotton patchwork fabric. 
Check out the Apple Core quilt instructions in the 
handy CutWork Ideas book that is included with 
the software. The bigger the embroidery hoop, the 
more shapes you can cut. Think about the fun you 
can have with flowers created with lots of layers, or 
party decorations made with crepe paper. My four-
year-old daughter loves the paper dolly’s I have 
made for her!

By Sarah Caldwell

with 
BERNINA 
CutWork
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with 
BERNINA 
CutWork

Preparing for CutWork
You will find that the knife cuts through most textiles with ease, but it is 
important to hoop a heavy stabilizer when cutting. Felt is the perfect fabric 
to use when you first start out with the BERNINA CutWork Tool, because it 
is so quick and easy to cut for craft projects. Treat knits, denim, toweling, 
and leather as you would when creating manual appliqué. Don’t forget thin 
rubber foam for fun rubber stamping. Once the stamp shape is cut, you 

have the remaining image in 
the foam to use for a stencil.

Rather than hooping thicker 
layers, they can be temporarily 
“glued” in place with 505 
spray; a basting stitch is also 
useful. I sandwich multiple 
layers between two sheets of 
heavy cut-away with some 
505 spray to adhere the layers 
before hooping them. Another 

great product is AquaMesh Plus. It’s perfect for anchoring your cut area in preparation for stitching. I love the fact that this washes away afterward. 

What Machines? 
BERNINA CutWork works with the complete BERNINA range of embroidery systems, artista 
180 right through to the new 830, including the Deco 340 (the only exceptions are the artista 
165/170). You simply set up the machine as for embroidery and attach the CutWork stitch plate. 
Then, depending on your project and the working order, you will either insert your CutWork needle 
first, or your embroidery needle and top and bottom threads. When cutting, you must first remove 
the top thread from the machine, but the bobbin thread can stay in place.

A Must for Creative People
There is something for every creative person who 
wants to cut a hole in something, or, alternatively, 
cut out a shape or shapes to be used in a project. 
CutWork in clothing is very popular right now, but 
this tool is also perfect for lace-making, appliqué, 
crafts, home dec projects, fabric, jewelry, and scrap-
booking. The list is endless! You don’t need sewing 
skills to use the CutWork tool; a little bit of computer 
experience helps, but the CutWork program is very 
easy to use.

The BERNINA CutWork Tool eliminates the tedious 
job – and, if you are like me, usually in the wee hours – of cutting out all those intricate shapes 
for your project. That means you will be able to finish your project so much more quickly, 
leaving more time to do even more projects! Contact your BERNINA dealer today to arrange a 
demonstration. You’ll be so glad you did! I’m just sure you will love using the CutWork Tool as 
much as I have – for all types of sewing and craft projects. It’s innovative and it’s fun!  
I think it’s the best newest thing since sliced bread!

Sarah Caldwell
 After ten years working for BERNINA New Zealand, Sarah 

moved to Switzerland to join the Marketing Team at BERNINA 
International. The original plan was one year. Eight years later, 

she’s still there. Sarah is responsible for Training and Education, 
supporting BERNINA Educators around the world. She is also heavily involved in product development and new 

product launches. In her spare time she loves to create eveningwear and wedding gowns for friends, including 
all sorts of embellishments, so easily done using BERNINA machines and software. 



www.berninausa.com

www.berninabsr.com

www.berninaUSAblog.com

www.berninaMyLabel.com

www.bernina8series.com

WEB&BLOGNews
Log on and see 

what’s new at 

www.berninausa.com

Log on, take a tour, and see a free show. 

You’ll also find free  BERNINA educational videos detailing 
the use of BERNINA presser feet and  accessories.

Alex Anderson Ricky Tims

36

BERNINA BLOG
Check out our blog at  
www.berninausablog.com for sewing news, 
tips & tricks, projects, and inspiration. Even 
if you don’t yet 
own a BERNINA 
you’ll find useful 
information in 
our blog for all 
your sewing 
adventures. 

Join BERNINA Webinar Events!
BERNINA Webinars are an innovative way to learn more about the exciting family of 
BERNINA products. From the BERNINA 8-Series Machines to My Label 3D Fashion 
Pattern Software to DesignerPlus V6 BERNINA Embroidery Software and more, 

BERNINA webinars are a fun and informative way to learn what’s 
new. Hosted by talented BERNINA Educators, our webinars 
bring you the latest tricks and techniques to make your sewing 
successful!

To join the free BERNINA Webinar Events, visit  
www.berninausa.com. Invitations to upcoming BERNINA 

Webinar Events are posted on the Home page throughout the month.

New Projects!
Visit www.berninausa.com often to 
download FREE projects and lessons. New 
projects are posted frequently, including 
the BERNINA 830 Reeds & Grasses Table 
Runner, Embroidered Wall Flowers Quilt, 
Holiday Gift Bags plus new DesignerPlus V6 
and Explorations software lessons! Be sure 
to look for the latest Quick on Your Feet 
postings for exciting specialty feet projects. 

Sewlebrity Scrapbook
Find out who’s sewing with Bernina! The most talented textile artists and teachers  
turn their ideas into creations using BERNINA sewing equipment. Visit  
www.berninausa.com>Sewlebirty Scrapbook for tips and projects from these artisans!

STORE LOCATOR
Looking for a BERNINA store near you? Use our Dealer 
Locator at www.berninausa.com. 



WEB&BLOG






